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ETAS はじめに
1 はじめに

本書は、ASCET 製品ファミリの構成を管理する方を対象としています。

本書はをお読みいただくには、ASCET 製品ファミリとオペレーティングシステム
（Microsoft Windows® Vista または Windows® 7）についての知識が必要です。

1.1 安全に関する注意事項

本製品を使用する際には、ユーザーの負傷やデバイスの損壊などを避けるため、製
品の信頼性に関する免責条項（「ETAS Safety Advice - 安全上の注意事項」）、および
下記の注意事項をよくお読みいただき、その指示に従ってください。

1.1.1 適切な製品の使用について

製品の不適切な使用や安全に関する注意事項に従わないことにより生じた一切の損
害について、ETAS GmbH は責任を負いません。

1.1.2 安全に関する注意事項の記述書式

本書内に記述されている安全に関する注意事項には、下記の標準シンボルが併記さ
れます。

安全に関する注意事項は以下の書式で記述されます。これらの情報は必ずよくお読
みください。

1.1.3 本製品に関する特殊な注意事項

本製品を安全に使用するには、一般的な注意事項に加え、以下の特殊な要件も守っ
てください。

• 本製品の準備や操作を行う前に、本製品を使用する環境が所定の条件を満た
していることを確認してください。各条件については、使用する PC やハー
ドウェアのドキュメントを参照してください。

さらに、他の関連するマニュアルの「安全に関する注意事項」の項や、製品 DVD に
収められている ASCET V6.2 安全マニュアル（サポート窓口までお問い合わせくだ
さい）に記載されている注意事項もよくお読みください。

警告！

中程度の危険性に関する注意事項です。記載事項を守らないと、重傷や
生命の危険を招く可能性があります。

注意！

軽度の危険性に関する注意事項です。記載事項を守らないと、軽～中程
度の負傷を招く危険性があります。

注記

物的損傷を招く可能性のある挙動についての説明です。
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1.2 ASCET の製品ドキュメント

ASCET 製品には、オンライヘルプと以下の PDF マニュアルが含まれています。以下
のファイルは、製品インストール時に ETAS¥ETASManuals¥フォルダにコピーさ
れます。

• ASCET V6.2 Installation.pdf 

• ASCET V6.2 Getting Started.pdf 

• ASCET V6.2 AUTOSAR Users Guide.pdf 

• ASCET V6.2 GUI Reference.pdf 

• その他 ASCET アドオン製品用マニュアル

1.3 本書について

1.3.1 本書の使用法

表現について

ユーザーが実行するすべてのアクションは、いわゆる “Use-Case” 形式で記述され
ています。つまり以下に示すように、操作を行う目標がタイトルとして最初に簡潔
に定義され（例：「新しいコンポーネントを作成する」、「エレメントの名前を変更す
る」）、その下に、その目標を実現するために必要な操作手順が列挙され、必要に応
じて ASCET のウィンドウやダイアログボックスのスクリーンショットが添付されて
います。

目標の定義：

前置き ...

• 操作 1

操作 1 についての説明 ...

• 操作 2

操作 2 についての説明 ...

• 操作 3

操作 3 についての説明 ...

まとめ ...

注記

主なマニュアルとオンラインヘルプについては日本語版も用意されており、これらの
ファイルは ETAS のホームページからダウンロードしていただくことができます。なお
オンラインヘルプにつきましては、バージョンによっては日本語版のリリースが遅れ
る場合がありますので、ご了承ください。詳しくはサポート窓口までお問い合わせく
ださい。
ASCET V6.2 - 管理ガイド
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具体例：

新しいファイルを作成する：

新しいファイルを作成する際は、他のファイルをすべて閉じておきます。

• File → New を選択します。

“Create file” ダイアログボックスが開きます。

• 新しいファイルの名前を、“File name” フィールドに
入力します。

ファイル名は 8 文字以内でなければなりません。

• OK をクリックします。

新しいファイルが作成され、ユーザーが指定した名前で保存されます。このファイ
ルを使用して以降の操作を行います。

表記上の規則

本書は以下の規則に従って表記されています。

特に重要な注意事項は、以下のように表記されています。

また PDF 文書において、索引、および他の部分を参照する個所（例：「xx を参照し
てください」の中の「xx」の部分）については、その参照先へのリンクが設けられ
ているので、必要な参照個所を素早く見つけることができます。

表記例 説明

File → Exit を選択して、... メニューコマンドは、青の太字で表記し
ます。

OK をクリックして、... ユーザーインターフェース上のボタン名
は、青の太字で表記します。

<Ctrl> を押して、... キーボードの各キーは、< > で囲んで表
記します。

“Open File” ダイアログボックスが
開きます。

プログラムウィンドウ、ダイアログボッ
クス、入力フィールド等のタイトル
は、“ ” で囲んで表記します。

setup.exeファイルを選択します。 リストボックス、プログラムコード、
ファイル名、パス名等のテキスト文字列
は、Courier フォントで表記します。

論理型のデータから算術型のデータへ
の変換はできません。

注意すべき個所、または新出の用語は太
字 、あるいは「 」で囲んで表記されま
す。

OSEK グループ（ÜííéWLLïïïKçëÉâJ
îÇñKçêÖL を参照してください）はさま
ざまな標準規格を策定しています。

インターネットへのリンクは、アンダー
ラインの付いた青い文字で表記されてい
ます。

注記

ユーザー向けの重要な注意事項
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2 ASCET オプションのカスタマイズ

ASCET オプションやプロジェクトプロパティの設定について、以下のような理由に
より社内の規定に合わせて制限する必要がある場合、本章で説明する「オプション
のカスタマイズ」機能を利用することができます。

• コーディングの社内規定などに応じて、ASCET オプションやプロジェクトプ
ロパティを所定の設定にする必要がある

• 不適切なオプション変更により、モデルの内容や生成されるコードの内容が、
不正になったりプロジェクト要件に合わなくなったりする可能性がある

• 不適切なオプション変更により問題が発生した場合、変更履歴をさかのぼっ
て解析するのが困難である 

2.1 項では、 ASCET のオプションとプロジェクトプロパティの XML 定義について説
明します。ASCET に用意されている外部オプションメカニズム（2.2 項）を用いて
独自の ASCET ユーザーオプションを追加することもでき、またオプションカスタマ
イズ機能（2.3 項および 2.4 項）を用いてオプションのデフォルト値を変更したり、
オプションを書き込み禁止にしたり、非表示にしたりすることもできます。

2.1 オプションの定義

各オプションは以下の基本フォーマットで定義されます。イタリック（斜体文字）
部分は、それぞれ適切な値に置き換える必要があります。

<OptionDeclaration

xmlCategory="path"

optionCategory="value"

optionClass="type"

attributeName="option name"

optionFile="filename.xml"

sensitive="true/false"

visible="true/false">

<Group>path</Group>

<Label>text</Label>

<Description>text</Description>

<Tooltip>text</Tooltip>

<InitialValue>value</InitialValue>

<DefaultValue>value</DefaultValue>

<Value>value</Value>1

<FileOption>definition</FileOption>2

<EnumerationOption>definition</EnumerationOption>2

<ButtonOption>definition</ButtonOption>2

<NumericOption>definition</NumericOption>2

</OptionDeclaration>

1. 自動的に生成されるオプションファイル内（10 ページと 2.4.1 項を参照）には存在し
ないため、ユーザーが追加する必要があります。*.aoc.xmlファイル内でのみ有効で
す。

2. 特殊な optionClass用にのみ有効です。 
ASCET V6.2 - 管理ガイド
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2.2 ASCET の外部オプション

ユーザー独自の要件に合わせて定義されたオプションを ASCET に追加するには、専
用の XML ファイルを使用します。このファイルには以下の拡張子を使用し、ASCET
のインストールディレクトリに格納します。

*.aod.xml

詳しくは ASCET オンラインヘルプの「コンポーネントマネージャ」セクションを参
照してください。

2.3 カスタマイズ機能

既存のオプションの宣言に使用される各種属性（2.1 項参照）については、カスタマ
イズできる内容は限られています。

表 2-1 カスタマイズ可能なオプション属性の概要

オプションを管理する主体は ASCET であるため、ユーザーがカスタマイズ機能を利
用して以下のことを行うことはできません。

• 既存のオプションを削除する

• 新しいオプションを追加する

• オプションタイプを変更する

• 内部オプション識別子を変更する

• 無効な値や不正な値をデフォルト値として使用する

• オプションの依存性を変更する（例 : オプション A が特定の値に設定されて
いる場合に限り、オプション B が編集可能になるようにする）

カスタマイズ

属性 可能 未対応 不可能

optionCategory ✓

attributeName ✓

optionClass ✓

xmlCategory ✓

sensitive ✓

visible ✓

optionFile ✓

<Group> ✓

<Label> ✓

<Description> ✓

<Tooltip> ✓

<InitialValue> ✓

<DefaultValue> ✓

<Value> ✓

<FileOption> ✓

<EnumerationOption> ✓

<ButtonOption> ✓

<NumericOption> ✓
9ASCET V6.2 - 管理ガイド



10

ASCET オプションのカスタマイズ ETAS
2.4 カスタマイズの手順

手順の概略 :

1. ASCET をインストールして起動する

2. ASCET オプションダイアログボックスからオプションカスタマイズ用ファイ
ル（*.aoc.xml）を作成する 

3. 適宜編集した *.aoc.xmlファイルを ASCET インストールディレクトリに
コピーする

（インストールのカスタマイズにより自動的にコピーされるようにすることも
できます）

4. ASCET を再起動する

起動時において ASCET は最初にビルトインオプション定義を読み込み、次に

*.aoc.xmlファイル内のカスタマイズされたオプション定義を読み込みま
す。

オプションカスタマイズ用ファイル（*.aoc.xml）のテンプレートを作成する :

• コンポーネントマネージャで Tools → Options を選
択して、ASCET オプションダイアログボックスを開
きます。

• オプションダイアログボックス左側のツリーペインが
アクティブになっていることを確認します。

• <ALT> + <D> を押します。

Windows のファイル選択ダイアログボックスが開き
ます。“ ファイル名 ” フィールドにはデフォルトの
ファイル名 OptionDeclarations.aoc.xmlが表
示されます。“ ファイルの種類 ” フィールドには

.xmlが表示され、変更はできません。

オプションカスタマイズ用ファイルには、必ず

*.aoc.xmlという拡張子を使用します。

• オプションカスタマイズ用ファイルのパスとファイル
名を指定し、保存 をクリックします。

オプションカスタマイズ用のテンプレートとして使用
できるファイルが保存されます。ファイルの内容は

11 ページの 2.4.1 項を参照してください。

オプションカスタマイズ用ファイル *.aoc.xmlを作成する :

• 生成されたテンプレートファイル *.aoc.xmlをテ
キストエディタで開きます。

• 新しい空のオプションカスタマイズ用ファイル
（*.aoc.xml）を作成します。

• 以下の行を新しいファイルにコピーします。

注記

生成されたファイルには、カスタマイズできないタイプのオプションも含まれて
います（2.4.2 項参照 )。ファイルを編集してオプションのカスタマイズを行う際
には、必ず前もってこれらのオプションを削除してください。
ASCET V6.2 - 管理ガイド
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<?xml version="1.0" encoding="US-ASCII"?>

<OptionDeclarations ↵
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="externalOptions.xsd">

</OptionDeclarations>

• カスタマイズしたいオプションの

<OptionDeclaration>セクション
（<OptionDeclarations ...>タグから

</OptionDeclarations>タグまで）を、テンプ
レートファイル（自動生成された *.aoc.xml ファ
イル）から新しいファイルにコピーします。

上記のように新しいファイルを作成する代わりに、テ
ンプレートファイルからカスタマイズできないオプ
ション（14 ページの 2.4.2 項を参照）の部分を削除
し、それを使用してカスタマイズを行うこともできま
す。

• カスタマイズしたいオプションについて、以下のよう
に編集します。

－ 当該オプションの <OptionDeclaration>セ
クションを探します。

－ オプションが「表示」されるようにするには、

visible属性を trueにします。

－ オプションを「非表示」にするには、visible
属性を falseにします。

－ オプションを「編集可」にするには、

sensitive属性を trueにします。

－ オプションを「編集不可」にするには、

sensitive属性を falseにします。

－ <Value>部分に適切な入力します。

－ <DefaultValue>部分に適切なデフォルト値を
入力します。.

• オプションカスタマイズ用ファイルを保存します。

カスタマイズされたオプションを有効にするには、オプションカスタマイズ用ファ
イルを各 ASCET ユーザー用の ASCET インストールディレクトリにコピーします。

2.4.1 生成されたオプションカスタマイズ用ファイルの内容

<?xml version="1.0" encoding="US-ASCII"?>

<OptionDeclarations ↵
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"↵
xsi:noNamespaceSchemaLocation="externalOptions.xsd">

注記

デフォルト値を変更しても、オプションのカレント値
は変更されません。
11ASCET V6.2 - 管理ガイド
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<OptionDeclaration ↵
optionCategory="FILE" ↵
attributeName="UserActionsBufferSize" ↵
optionClass="EtasNumericOption" ↵
xmlCategory="ToolSettings" ↵
visible="true" ↵
sensitive="true" ↵
optionFile="d:\ETASData\ASCET6.2\User\ml_user\ ↵

userSettings.xml">

<Group></Group>

<Label>User Actions Buffer Size</Label>

<Description>Define the size of last ↵
&amp;lt;i&amp;gt;n&amp;lt;/i&amp;gt; user actions ↵
that are stored and transmitted on a walkback ↵

</Description>

<Tooltip>Number of user actions to be Stored</Tooltip>

<InitialValue>100</InitialValue>

<DefaultValue>100</DefaultValue>

<NumericOption>

<MinValue>0</MinValue>

<MaxValue>1000</MaxValue>

</NumericOption>

</OptionDeclaration>

...

<OptionDeclaration ↵
optionCategory="FILE" ↵
attributeName="WatermarkShow" ↵
optionClass="EtasContainerOption" ↵
xmlCategory="EditorSettings\BlockDiagram" ↵
visible="true" ↵
sensitive="true" ↵
optionFile="d:\ETASData\ASCET6.2\User\ml_user\ ↵

userSettings.xml">

<Group>Appearance\Editors\Block Diagram</Group>

<Label>Show Watermark</Label>

<Description>Show Watermarks (e.g. the currently ↵
selected View) in BDE</Description>

<Tooltip>Show Watermarks in BDE</Tooltip>

<InitialValue>true</InitialValue>

<DefaultValue>true</DefaultValue>

</OptionDeclaration>

<OptionDeclaration ↵
optionCategory="FILE" ↵
attributeName="WatermarkSize" ↵
optionClass="EtasNumericOption" ↵
xmlCategory="EditorSettings\BlockDiagram" ↵
visible="true" ↵
sensitive="true" ↵
optionFile="d:\ETASData\ASCET6.2\User\ml_user\ ↵
ASCET V6.2 - 管理ガイド
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userSettings.xml">

<Group>Appearance\Editors\Block Diagram</Group>

<Label>Watermark Size (px)</Label>

<Description>Fontsize of the  Watermark in BDE ↵
</Description>

<Tooltip>Size of the Watermark</Tooltip>

<InitialValue>20</InitialValue>

<DefaultValue>20</DefaultValue>

<NumericOption>

<MinValue>1</MinValue>

<MaxValue>200</MaxValue>

</NumericOption>

</OptionDeclaration>

...

<OptionDeclaration ↵
optionCategory="FILE" ↵
attributeName="PageNumberShow" ↵
optionClass="EtasBooleanOption" ↵
xmlCategory="EditorSettings\BlockDiagram" ↵
visible="true" ↵
sensitive="true" ↵
optionFile="d:\ETASData\ASCET6.2\User\ml_user\ ↵

userSettings.xml">

<Group>Appearance\Editors\Block Diagram</Group>

<Label>Show Page Number</Label>

<Description>Show the page number in the BDE ↵
</Description>

<Tooltip>Show Page Number in BDE</Tooltip>

<InitialValue>false</InitialValue>

<DefaultValue>false</DefaultValue>

</OptionDeclaration>

...

<OptionDeclaration ↵
optionCategory="FILE" ↵
attributeName="DisplayConnectionPortSelectionBox" ↵
optionClass="EtasBooleanOption" ↵
xmlCategory="EditorSettings\BlockDiagram" ↵
visible="true" ↵
sensitive="true" ↵
optionFile="d:\ETASData\ASCET6.2\User\ml_user\ ↵

userSettings.xml">

<Group>Appearance\Editors\Block Diagram</Group>

<Label>Display Connection Port Selection Box</Label>

<Description>Only in Connection Mode: With the mouse↵
over the diagram elements there is an extra ↵
selection box showed for the selection of the ↵
connection ports.</Description>
13ASCET V6.2 - 管理ガイド
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<Tooltip>Display the Connection Port Selection Box ↵
</Tooltip>

<InitialValue>true</InitialValue>

<DefaultValue>true</DefaultValue>

</OptionDeclaration>

...

</OptionDeclarations>

2.4.2 カスタマイズが不可能な ASCET オプション

カスタマイズできるオプションは、単純な値が設定されるタイプのオプションに限
定されます。以下に示す例のような複雑な設定が必要なオプションについてはカス
タマイズは行えませんが、「表示」／「非表示」、および「編集可」／「編集不可」
を指定することはできます。

• ボタン、およびリンクを指定するオプション
（optionClass="EtasButtonOption"）

• 複数の項目を設定するオプション 
（optionClass="EtasMultiSelectConfigurationOption"）
ASCET V6.2 - 管理ガイド
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• 複数の項目を選択するオプション
（optionClass="EtasMultiSelectEnumerationOption"）

• チャイルドオプションを含むコンテナオプション
（optionClass="EtasContainerOption"） 

• optionClass="EtasEditableEnumerationOption"のオプション

注記

コンテナオプションを非表示にすると、そのチャイルドオプションも非表
示になります。
15ASCET V6.2 - 管理ガイド
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ASCET オプションのカスタマイズ ETAS
• optionclass="EtasEditableXMLFileOption" （A）または

"EtasPathTokenFileOption"（B）のオプション

2.4.3 オプションカスタマイズ用ファイル *.aoc.xmlのカスタマイズ例

一例として、下図に示される ASCET オプションダイアログボックスの “Block 
Diagram” ノードの 3 つのオプション Display Connection Port Selection Box、

Show Watermark、Show Page Number は、デフォルトにおいては「表示」モー
ドで、かつ「編集可」になっています。同じノードの Watermark size (px) も「表
示」モードですが、Show Watermark がオンになっている場合にのみ「編集可」
になります。

図 2-1 オプションの表示内容（システムデフォルト値）

以下に、*.aoc.xmlファイルでこれら 4 つのオプションをカスタマイズする方法
をご紹介します。変更または追加された部分は青い文字、オプション名は太字で示
されています。

<?xml version="1.0" encoding="US-ASCII"?>

<OptionDeclarations ↵
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

↵
xsi:noNamespaceSchemaLocation="externalOptions.xsd">

<OptionDeclaration ↵
optionCategory="FILE" ↵
attributeName="WatermarkShow" ↵
optionClass="EtasContainerOption" ↵
xmlCategory="EditorSettings\BlockDiagram" ↵
visible="true" ↵

A
B
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sensitive="false" ¿
optionFile="d:\ETASData\ASCET6.2\User\ml_user\ ↵

userSettings.xml">

<Group>Appearance\Editors\Block Diagram</Group>

<Label>Show Watermark</Label>

<Description>Show Watermarks (e.g. the currently ↵
selected View) in BDE</Description>

<Tooltip>Show Watermarks in BDE</Tooltip>

<InitialValue>true</InitialValue>

<DefaultValue>true</DefaultValue>

</OptionDeclaration>

<OptionDeclaration ↵
optionCategory="FILE" ↵
attributeName="WatermarkSize" ↵
optionClass="EtasNumericOption" ↵
xmlCategory="EditorSettings\BlockDiagram" ↵
visible="true" ↵
sensitive="true" ↵
optionFile="d:\ETASData\ASCET6.2\User\ml_user\ ↵

userSettings.xml">

<Group>Appearance\Editors\Block Diagram</Group>

<Label>Watermark Size (px)</Label>

<Description>Fontsize of the  Watermark in BDE ↵
</Description>

<Tooltip>Size of the Watermark</Tooltip>

<InitialValue>20</InitialValue>

<DefaultValue>50</DefaultValue>ml_user

<Value>50</Value>

<NumericOption>

<MinValue>1</MinValue>

<MaxValue>200</MaxValue>

</NumericOption>

</OptionDeclaration>

<OptionDeclaration ↵
optionCategory="FILE" ↵
attributeName="PageNumberShow" ↵
optionClass="EtasBooleanOption" ↵
xmlCategory="EditorSettings\BlockDiagram" ↵
visible="true" ↵
sensitive="false" ¿
optionFile="d:\ETASData\ASCET6.2\User\ml_user\ ↵

userSettings.xml">

<Group>Appearance\Editors\Block Diagram</Group>

<Label>Show Page Number</Label>

<Description>Show the page number in the BDE ↵
</Description>

<Tooltip>Show Page Number in BDE</Tooltip>
17ASCET V6.2 - 管理ガイド
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<InitialValue>false</InitialValue>

<DefaultValue>true</DefaultValue>

<Value>true</Value>

</OptionDeclaration>

<OptionDeclaration ↵
optionCategory="FILE" ↵
attributeName="DisplayConnectionPortSelectionBox" ↵
optionClass="EtasBooleanOption" ↵
xmlCategory="EditorSettings\BlockDiagram" ↵
visible="true" ↵
sensitive="true" ↵
optionFile="d:\ETASData\ASCET6.2\User\ml_user\ ↵

userSettings.xml">

<Group>Appearance\Editors\Block Diagram</Group>

<Label>Display Connection Port Selection Box</Label>

<Description>Only in Connection Mode: With the mouse
↵

over the diagram elements there is an extra ↵
selection box showed for the selection of the ↵
connection ports.</Description>

<Tooltip>Display the Connection Port Selection Box ↵
</Tooltip>

<InitialValue>true</InitialValue>

<DefaultValue>true</DefaultValue>

<Value>false</Value>

</OptionDeclaration>

</OptionDeclarations>

上記のように変更したファイルをユーザーの ASCET インストールディレクトリにコ
ピーして ASCET を起動すると、 同じ “Block Diagram” ノードの内容は以下のように
なります。

図 2-2 オプションの表示内容（<Value>と <DefaultValue>をカスタマイズ）

Show Watermark オプションと Show Page Number オプションは編集不可にな
り、さらに *.aoc.xmlファイル内に追加された <Value> パラメータにより、カ
レント値が変更されています（図 2-1 参照）。
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もしも <Value>パラメータを追加せずに <DefaultValue>パラメータの変更の
みを行った場合は、“Block Diagram” ノードは図 2-2 とは若干異なる内容になりま
す。カレントオプション値は変更していないので、オプションの値は 図 2-1 に示さ
れるシステムデフォルト値のままとなります。

図 2-3 オプションの表示内容（<DefaultValue>をカスタマイズ）

System Defaults ボタンをクリックすると、カレントノード上のすべてのオプショ
ンにデフォルト値がセットされます。

ASCET を閉じて再起動しても、変更された値とデフォルト値がそのまま保持されて
います。
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3 ASCET-DIFF – デフォルト設定のカスタマイズ

ASCET-DIFF で ASCET モデルの比較を行う際に、社内の規定に合わせて ETAS デ
フォルトコンフィギュレーションを変更することができます。

3.1 項で、比較コンフィギュレーションが ASCET-DIFF 内でどのように扱われるかを
説明し、3.2 項でそのデフォルト設定を変更する方法を説明します。

3.1 ASCET-DIFF プリファレンス

ASCET-DIFF の “Preferences” ダイアログボックスには、さまざまな比較コンフィ
ギュレーションが含まれています。

図 3-1 ASCET- DIFF – “Preferences” ダイアログボックス

ASCET-DIFF をインストールすると、ETAS のデフォルトコンフィギュレーションが
含まれる ASCII ファイル DamePreferences.propertiesが作成され、 
ASCET-DIFF インストールディレクトリ下の

plugins\com.etasgroup.ascet.diff.mainui_1.0.0\resourceに保
存されます。

ユーザーが ASCET-DIFF を最初に起動すると、“Preferences” ダイアログボックス内
の各オプションに DamePreferences.propertiesファイル内の値がセットさ
れ、さらにこのファイルが ASCET-DIFF ワークスペースロケーション

workspace\<user name> にコピーされます。ユーザーが “Preferences” ダイア
ログボックスで設定を変更すると、その内容は ...\workspace\<user 
name>\DamePreferences.propertiesに保存されます。

“Preferences” ダイアログボックスの各ノードの Restore Defaults ボタンをクリッ
クすると、そのノード上での変更内容が破棄され、デフォルト値に戻ります。

3.2 デフォルト設定の変更

ETAS デフォルト設定の変更は、以下の手順で行います。

• DamePreferences.propertiesファイルをコピーし、 要件に合わせて
内容を変更します（3.2.1 項と 3.2.2 項を参照してください）。

• 変更した DamePreferences.propertiesファイルを配布します（3.2.3
項を参照してください）。

注記

ASCET オプションとは異なり、ASCET-DIFF の比較コンフィギュレーションを
「編集不可」に設定することはできません。各ユーザーはデフォルト値を自由に変
更することができます。
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ンが表示される “Preferences” ダイアログボックス内

ータ － “Preferences” ダイアログボックス内の位置

 Tolerance 
thers” ノード

ntage of transitions to be matched to pick 
ions for comparison (%) － “Others” ノード

 email if comparison fails
thers” ノード

re comments in State machine
omparison and Component Settings” ノード

rent item color － “Colors” ノード

ay schema migration information/warning(s) 
g － “Others” ノード

ss comparison option フィールド

omparison and Component Settings” ノード

pare Block Diagram/State Machine with SiDiff
omparison and Component Settings” ノード

de
efault View” ノード

parison Variants フィールド

omparison and Component Settings” ノード

t new item color
olors” ノード

SAR Calibration Interface
efault View” ノード
.2.1 DamePreferences.propertiesファイルをカスタマイズする

表 3-1 に DamePreferences.propertiesファイル内のエントリと、対応するオプショ
の位置（ノード名）を示します。

*.properties内のエントリ 有効な値 パラメ

tolerance 整数 Pixel
－ “O

doSort 現在は使用されていません。 ---

triggerLevel [0..100] Perce
junct

sendEmail true / false Send
－ “O

ignoreSMComments true / false Igno
－ “C

diffElement [0..255],[0..255],[0..255] Diffe
displaySchemaMigrationWarnings true / false Displ

dialo
compareProcess name / index Proce

－ “C
sidiff true / false Com

－ “C
ccodeIndex [0..9] C Co

－ “D
compare flat / quick / detailed Com

－ “C
deletedElement [0..255],[0..255],[0..255] Righ

－ “C
cbrIndex [0..6] AUTO

－ “D



22
A

SC
ET V

6.2 - 管
理

ガ
イ

ド

A
SC

ET-D
IFF

– デ
フ

ォ
ル

ト
設

定
の

カ
ス

タ
マ

イ
ズ

ETA
S

D
 “Default View” ノード

nore comments, spaces and blank lines in ESDL/
Code
 “Comparison and Component Settings” ノード

UTOSAR Client Server
 “Default View” ノード

nore sequence calls
 “Comparison and Component Settings” ノード

isplay prompt on exit dialog
 “Others” ノード

ot compared item color
 “Colors” ノード

g Model Characteristics
 “Others” ノード

efered delete count for overview tree
 “Others” ノード

ft new item color 
 “Colors” ノード

DL
 “Default View” ノード

omponent selection option フィールド

 “Comparison and Component Settings” ノード

ompare order of sequence calls
 “Comparison and Component Settings” ノード

nore label position
 “Comparison and Component Settings” ノード

ラメータ － “Preferences” ダイアログボックス内の位置
bdIndex [0..8] B
－

ignoreESDLComments true / false Ig
C
－

csrIndex [0..6] A
－

ignoreSequenceCalls true / false Ig
－

promptOnExit true / false D
－

uncomparedElement [0..255],[0..255],[0..255] N
－

logFeature true / false Lo
－

preferedDeleteCount integer number Pr
－

newElement [0..255],[0..255],[0..255] Le
－

esdlIndex [0..8] ES
－

compareComponents sameName / sameOID / 
twoSelected

C
－

compareSeqCallOrder true / false C
－

ignorePosition true / false Ig
－

*.properties内のエントリ 有効な値 パ
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pare open and closed hierarchy state
omparison and Component Settings” ノード

SAR Sender Receiver
efault View” ノード

nt Comparison Count
thers” ノード

efault View” ノード

ct
efault View” ノード

SAR Software Component
efault View” ノード

re comments in BD
omparison and Component Settings” ノード

ont” ノード

e group
efault View” ノード

re notes
omparison and Component Settings” ノード

 Size
ont” ノード

re comments in Elements
omparison and Component Settings” ノード

 Header Page
rinting” ノード

mum scale factor for Intelligent Layout
rinting” ノード

ータ － “Preferences” ダイアログボックス内の位置
compareOpenClosedHierarchy true / false Com
－ “C

snrIndex [0..6] AUTO
－ “D

recentComparisonEntries 整数 Rece
－ “O

enumIndex [0..2] Enum
－ “D

projectIndex [0..12] Proje
－ “D

swcIndex [0..11] AUTO
－ “D

ignoreBDComments true / false Igno
－ “C

Font PC にインストールされている
フォント

Font
－ “F

modeGroupIndex [0..2] Mod
－ “D

ignoreNotes true / false Igno
－ “C

FontSize 8, 9, 10, 11 Font
－ “F

ignoreElementComments true / false Igno
－ “C

printHeaderPage true / false Print
－ “P

minimumScaleFactor 数値 Mini
－ “P

*.properties内のエントリ 有効な値 パラメ
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nces” ダイアログボックス内の対応するパラメータと位置

る値は表 3-1 の 2 列目を参照してください。コメント行を
こともできます。

ontainer
 “Default View” ノード

ecord
 “Default View” ノード

UTOSAR NVData Interface
 “Default View” ノード

entical item color
 “Colors” ノード

nore element OID and method OID,
 “Comparison and Component Settings” ノード

atemachine － “Default View” ノード

nore layout
 “Comparison and Component Settings” ノード

go file path
 “Printing” ノード

ラメータ － “Preferences” ダイアログボックス内の位置
表 3-1 DamePreferences.properties内のエントリと設定値、および “Prefere

エントリを変更するには、テキストエディタでファイルを開いて編集します。設定でき

# <comment text> という形式で追加したり、変更の必要がない行を削除したりする

containerIndex [0..3] C
－

recordIndex [0..6] R
－

nvdIndex [0..6] A
－

sameElement [0..255],[0..255],[0..255] Id
－

ignoreElementOID true / false Ig
－

smIndex [0..8] St
ignoreLayout true / false Ig

－

logoFilepath グラフィックファイルのパスとファイ
ル名（*.jpg/*.png/*.bmp）

Lo
－

*.properties内のエントリ 有効な値 パ
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3.2.2 DamePreferences.propertiesファイルのカスタマイズ例

オリジナルの DamePreferences.propertiesファイルには、

option=valueという形式のデータが順不同で格納されています。

以下に DamePreferences.propertiesファイルの変更例を示します。また以
下のファイルでは、各エントリが “Preferences” ダイアログボックスに表示される
ノード別にソートされています。 変更された設定は青い太字で示されています。

#Fri May 17 15:08:35 CEST 2013

#

#Comparison and Component Settings

compare=flat

compareComponents=twoSelected

compareOpenClosedHierarchy=true

compareProcess=index

compareSeqCallOrder=false

ignoreBDComments=true

ignoreElementComments=true

ignoreElementOID=true

ignoreESDLComments=true

ignoreLayout=false

ignoreNotes=false

ignorePosition=true

ignoreSequenceCalls=false

ignoreSMComments=true

sidiff=true

#

#Default View

bdIndex=0

cbrIndex=0

ccodeIndex=0

containerIndex=0

csrIndex=0

esdlIndex=0

enumIndex=0

modeGroupIndex=0

nvdIndex=0

projectIndex=0

recordIndex=0

smIndex=0

snrIndex=0

swcIndex=0

#

#Colors node
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deletedElement=255,0,0

diffElement=0,0,255

newElement=0,255,0

sameElement=0,0,0

uncomparedElement=128,128,128

#

#Font node

Font=Tahoma

FontSize=8

#

#Printing node

logoFilepath=C:\CI\icons\BMP\AscetDiff_48.bmp

minimumScaleFactor=1.0

printHeaderPage=true

#

#Others node

displaySchemaMigrationWarnings=true

logFeature=false

preferedDeleteCount=5

promptOnExit=true

recentComparisonEntries=10

sendEmail=false

tolerance=11

triggerLevel=75

#

doSort=true

3.2.3 変更した DamePreferences.propertiesファイルの配布

変更した DamePreferences.propertiesファイルを各ユーザーの ASCET-DIFF
インストールディレクトリに配布するには、以下のような手順で行います。

1. ASCET-DIFF インストールパスを確認します。

パスは以下のロケーションにあるレジストリキーで確認できます。

－ 64 ビットオペレーティングシステムの場合 : 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ETAS\ 
ASCET-DIFF\6.2

－ 3264 ビットオペレーティングシステムの場合 : 
HKEY_LOCAL_MACHINE\SOFTWARE\ETAS\ASCET-DIFF\6.2

2. ASCET-DIFF インストールパスに
\plugins\com.etasgroup.ascet.diff.mainui_1.0.0\ 
resourceを追加します。

追加したパスは以下のようになります。

C:\ETAS\ASCET-DIFF6.2\plugins\ ↵
com.etasgroup.ascet.diff.mainui_1.0.0\resource
ASCET V6.2 - 管理ガイド
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3. 変更した DamePreferences.propertiesファイルを追加したパスにコ
ピーします。

上記の手順はスクリプトで自動実行することもできます。

変更された DamePreferences.propertiesファイルが所定のロケーションに
コピーされると、直ちにその内容が、 ASCET-DIFF“Preferences” ダイアログボックス
の Restore Defaults ボタンで設定されるデフォルト値になります。

注記

変更済み DamePreferences.propertiesファイルは、ユーザー定義された
既存のプリファレンス設定を上書きしません。
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4 お問い合わせ先

製品に関するご質問等は、各地域の ETAS 支社までお問い合わせください。

ETAS 本社

ETAS GmbH

日本支社

イータス株式会社

その他の支社

上記以外の各国支社および技術サポート窓口につきましては、ETAS ホームページを
ご覧ください。

Borsigstrasse 14 Phone: +49 711 89661-0

70469 Stuttgart Fax: +49 711 89661-106

Germany WWW: www.etas.com/

〒 220-6217

神奈川県横浜市西区 Phone: (045) 222-0900

みなとみらい 2-3-5 Fax: (045) 222-0956

クイーンズタワー C 17F WWW: www.etas.com/

各国支社 WWW: www.etas.com/ja/contact.php

技術サポート WWW: www.etas.com/ja/hotlines.php

http://www.etas.com/ja/hotlines.php
http://www.etas.com/ja/
http://www.etas.com/
http://www.etas.com/ja/
http://www.etas.com/
http://www.etas.com/ja/contact.php
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